eMedia Card Designer
Quick Start Guide

This document and the accompanying software are trade marks of Mediasoft Technologies. No part of this document may be reproduced by any way, mechanical, electronic, photographic and others, without the prior written agreement of Mediasoft Technologies.
As we modify and enhance the software and the documentation every day, its contents may be changed at any time without advice.
This document contains references to trade marks. IBM, PC are registered trade marks of International Business Machines, Inc. Intel, Pentium are registered trade marks of Intel Corporation. Microsoft Windows, Microsoft Word, Microsoft Excel, COM, DCOM, Microsoft Visual Basic, Microsoft Visual C++, Microsoft Visual Studio are registered trade marks of Microsoft Corporation. Adobe Acrobat is a registered trade mark of Adobe Systems Incorporated.

The eMedia Card Designer computer program has been designed to run on any IBM PC or compatible micro-computer running the Microsoft Windows, versions 9x, NT, 2000, XP or 2003 operating systems.

This software is a COM/DCOM Server component, strictly developed according to the COM/DCOM specifications defined by Microsoft Corporation.

Please refer to the User License and the Limited Warranty for any questions regarding the usage of the license granted to you by Mediasoft Technologies.

Should you have any question regarding this document, its contents or the eMedia Card Designer software, please feel free to contact us:

Web: http://www.emedia-cards.com

e-mail: support@emedia-cards.com

Postal address:

Mediasoft Technologies
228, rue de la Convention
75015 Paris – France

This Quick Start Guide is provided to you for free by Mediasoft Technologies in order to help you in your first steps using the eMedia Card Designer software. This guide, as the computer program, may be freely downloaded from our internet web site.
# TABLE OF CONTENTS

1. **INTRODUCTION** ................................................................................................................................................. 4  
   What is eMedia Card Designer? ......................................................................................................................... 4  
   Editions of eMedia Card Designer .................................................................................................................. 4  
   Activation of your eMedia Card Designer license ........................................................................................... 6  

2. **DESIGNING A CARD TEMPLATE** ........................................................................................................................... 8  
   Launching eMedia Card Designer ....................................................................................................................... 8  
   The elements provided to the user in design mode ............................................................................................. 9  
   The current card template ................................................................................................................................. 9  
   The toolbox ..................................................................................................................................................... 9  
   The properties pane ..................................................................................................................................... 9  
   The background of our card ............................................................................................................................ 10  
   The identity picture of the card holder ............................................................................................................. 11  
   Let's go a little bit further ............................................................................................................................... 12  
   The holder's name and other text objects ....................................................................................................... 12  
   The sources of the data ................................................................................................................................ 13  
   Presenting the information ............................................................................................................................... 14  
   Giving some help to the user ............................................................................................................................ 15  
   Exercise ....................................................................................................................................................... 15  
   Let's go a little more further ............................................................................................................................. 16  
   A barcode with the membership number ........................................................................................................ 18  
   Characteristics of the print counter ................................................................................................................ 19  
   The magnetic strip ....................................................................................................................................... 20  
   Connection to a database ................................................................................................................................. 22  
   Defining the database connection .................................................................................................................... 22  
   Defining the link between the objects and the fields ...................................................................................... 26  
   Formulas and database fields ............................................................................................................................ 27  
   Let's go further with the "Database choice" ..................................................................................................... 27  
   More and more further ................................................................................................................................ 28  
   Let's put the finishing touches ........................................................................................................................ 29  

3. **THE OPERATING MODE** ................................................................................................................................. 30  
   Launching eMedia Card Designer in operating mode ..................................................................................... 30  
   Opening a card template ..................................................................................................................................... 31  
   The input window .......................................................................................................................................... 31  
   Image acquisition .......................................................................................................................................... 32  
   Using a database ........................................................................................................................................... 32  
   The data grid ................................................................................................................................................ 32  
   Finding records .......................................................................................................................................... 33  
   Batch printing ............................................................................................................................................ 34  
   CoolReader™ .......................................................................................................................................... 35  
   Printing the card out ..................................................................................................................................... 38  

4. **REGISTERING YOUR SOFTWARE COPY** .......................................................................................................... 40  
   Principle of the software keys .......................................................................................................................... 40  
   The Installation Key ...................................................................................................................................... 40  
   The Activation Key ...................................................................................................................................... 40  
   The License Key ......................................................................................................................................... 41  
   The Migration Key ...................................................................................................................................... 41  
   Let's activate our software copy ...................................................................................................................... 41  
   Migration of a license ................................................................................................................................... 47  
   Uninstalling the license ................................................................................................................................. 47  
   Installation of the license ............................................................................................................................... 48  
   Help, I lost my license! .................................................................................................................................. 51  
   Problems or questions? ................................................................................................................................ 51  

5. **CONTACT US** ................................................................................................................................................... 52
1. INTRODUCTION

Any documentation always begins with a little introduction text, in which we'll talk about some basic principles of the software: available editions, activation and some notices about the way to read this guide.

Please take a moment to read this introduction. You'll understand the role and the way the software runs so you'll be able to use it as efficiently as possible.

What is eMedia Card Designer?

The software is an integrated application that allows you to design and print plastic cards on any card printer.

Of course, you may use any existing and installed program on your computer to do, but eMedia Card Designer also allows you to:

- Encode the magnetic strips, the Smart Card and the Contactless Smart Card,
- Help people with low skill level in computing to print out cards in just a few seconds,
- To print out data contained in your own databases,
- To print out calculated data,
- To store information that relates to the cards printouts and the program usage in a database or in a log file,
- To print in a single pass on cards: texts, images, barcodes, the holder's picture acquired from any Twain / WIA camera or webcam.

For these purposes, eMedia Card Designer was developed to be used in three distinct modes:

The **design mode** allows the creation of the template of the card. This template contains all the information that relates to the contents of the card and the way to use it to print the plastic cards out.

This mode is used by the card creator, the application developer or the solution integrator, from the elements defined by the graphic team and from the available data.

The **operating mode** allows the user to enter the data that must be printed on the card or entered in the database linked to the card, and/or to be encoded. The information, defined in the card template, will be entered from a specific input window dedicated to this usage.

This mode will be used by the people in charge of printing the plastic cards out, from the templates defined by the designer. The utilization of this mode doesn't require any computer skill. The person in charge of entering the data has only to enter the information and to print the card out.

The **COM Server mode** (Component Object Model) allows you to add to a third-party program the ability to print and encode plastic cards, using eMedia Card Designer as an expansion module.

This mode will be used by the application developer or the solutions integrator. It allows the printout and the encoding of plastic cards from a template defined in design mode and from code in his/her own program.

Editions of eMedia Card Designer

eMedia Card Designer exists in four editions for different kinds of utilization and features needed. Three of these four editions require the user license to be activated, and this aspect of the software will be described below.
While installing the software on your computer, this one contains all the features of the Expert edition, but only the Trial edition features are enabled, or the Standard edition features when used in conjunction with one of the printer of our partners.

You may activate an edition at any time, just by entering in the software a string of characters, also called an Activation Key. This key must only be entered once; its purpose is to unlock the corresponding features.

In addition to these four editions, eMedia Card Designer also contains a specific functionality, called "demonstration mode", in which all the software features can be checked out. You may then define by yourself the edition that best fits your needs and decide to buy the corresponding license: Professional or Expert.

The "Trial" edition works like a "Standard" edition for 30 days after the program installation. After this initial period, this edition is not able to print out production cards anymore, but only demonstration cards.

In demonstration mode, the software cannot also print any production card, and only prints out demonstration cards. These ones look like the production cards, but they contain the label "DEMONSTRATION" on them so they can't be used for a normal usage. These demonstration cards are intended to show the correct printing of the documents while their utilization isn't possible. In this mode, the encodings are not also performed (magnetic strips, smart card and contactless smart card).

The differences between the four editions of eMedia Card Designer are displayed in this table.

A column, reserved to the demonstration mode, displays the features this mode allows.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Trial</th>
<th>Standard</th>
<th>Professional</th>
<th>Expert</th>
<th>Demonstration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design and printouts of plastic cards</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Printouts of demonstration cards (see below)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnetic strip encoding</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Smart card encoding (external program)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contactless smart card encoding (external program)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contactless smart card encoding (internal process)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Database utilization (MS-Excel worksheets)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Database utilization (all standard database types)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Using formulas in text and barcode objects</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Using plug-ins</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Using COM Server features</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
Activation of your eMedia Card Designer license

To activate your software license, you must own an Installation Key and the corresponding Activation Key.

The Installation Key is a string of letters and digits beginning with the three characters "IK-". It is automatically generated when your copy of the software is installed on your computer. This key is unique, as it is created from data specific to your installation.

The Activation Key is a string of letters and digits beginning with the three characters "AK-". This key is provided to you by an e-mail sent by the eMedia Card Designer License Server, always available on the internet at the following URL: http://www.emedia-cards.com.

The Installation and Activation Keys are unique and each one depends from the other. It's the combination of these two keys that unlocks the advanced features of the software.

How to obtain an Activation Key?

Your local reseller can't send directly to you an Activation Key. So he provided instead, when you ordered your license, a third key, called "License Key", as a string of letters and digits, beginning with the three characters "LK-".

This License Key is a "proof of purchase ". It allows our License Server to deliver your Activation Key.

How to activate my own copy of the software?

If you obtained a License Key, start the software, open the "Help" menu and select the "Register your license..." command. Click on the "Register now" button and follow the steps in the next pages displayed on screen.

In these ones, you'll enter your License Key and your personal information (name, company, e-mail address). The software will transmit all these information (with your prior agreement) to our License Server, and this one will send back your Activation Key, by e-mail. You'll only have to enter this key in the dedicated text-box in the software.

Please check out your anti-spam software to avoid to quarantine or reject any message that could have been sent by our License Server, otherwise you will not receive your Activation Key. To do so, add a rule in your anti-spam software to consider as regular any message sent by the SMTP server "suptel.net", sent by a user belonging to the "emedia-cards.com" domain.
For details about this procedure, please refer to the "Activation of your software copy" section in this guide.

**How to move my license?**

If you want to move your license from a computer to another one, please refer to the section that concerns the activation later in this guide. This step-by-step procedure is described there.

**I have lost my license!**

Your license may disappear from your computer and may be forever lost, in case of a hardware failure (e.g. hard disk crash) or a software failure (e.g. virus attack).

In this case, please contact or sales department directly, from our internet web site. We'll study with you all the possible options that may allow you to fix this issue.
2. DESIGNING A CARD TEMPLATE

Let's start the software and review the first basic knowledge. In this chapter, we'll introduce the design mode and the operating mode, and will print out our first cards.

Launching eMedia Card Designer

To start the application, we may either use the icon created on the desktop by the installation program, or use in the "Start" menu, "All programs", the "eMedia Card Designer" program group, where many icons were created, such as:

- **eMedia Card Designer** to launch the program in operating mode for printing cards out.
- **Sample card templates** to launch an external program that allows you to automatically open a sample card template in eMedia Card Designer.
- **Start Design mode** to launch the software in design mode for designing card templates.
- **Tutorial** to launch an external program that will help you to learn how to use eMedia Card Designer, from video sequences.

We will now begin a new card template. To do that, we'll use the third shortcut in the "Start" menu: "Start Design mode".

A splash screen appears, immediately followed by the main design window:

![First launch of eMedia Card Designer in design mode](attachment:image)

The first time we launch eMedia Card Designer, the "Demo mode" dialog box asks us if we want to enable or not the demonstration mode.
In this mode, all the features of the software are enabled, including the ability to configure the magnetic strips, the Smart Card and the Contactless smart card contents. But this mode also locks out the printout: all the printed cards will have a big "DEMONSTRATION" text on their middle, and no encoding will be performed.

Click on the "Enable demonstration mode" to be able to use all the software features. We'll be able to disable this mode later from the "Help" menu.

The elements provided to the user in design mode

The main window of the application contains common elements we can find in any Windows application: a menu bar and a toolbar at the top of the window. A status bar at the bottom of the window gives useful information concerning the localization and the keyboard state.

The window also contains three specific elements: the current card template, the toolbox and the properties pane.

The current card template

The template is located in the central part of the window, and should be empty at this time. We'll add to this template a background picture and the objects to print out. The bar at the top of the template shows the card side and the current zoom level.

When a double-sided card is to be designed, two elements like this one are displayed: one for the front side, one for the back side.

We may change the zoom level for the active side, from the "View" menu or by pressing the F8 key on the keyboard.

A grid helps us to adjust the position of the objects. The step of the grid and the magnetic comportment of the mouse may be defined from the card properties.

The toolbox

On the left of the window, a vertical panel contains all the objects we may add to the card layout during the design of the card template: text objects, images, photos, barcodes, lines, rectangles, ovals, magnetic strip programming, smart card programming, contactless smart card programming and two additional tools for changing their order.

When we move the mouse over one of these icons, a tooltip appears, showing us the kind of the corresponding object.

The objects are grouped by categories. We may change the category by clicking on the corresponding tab: a click on "Drawing" shows the drawing objects (lines, rectangles and ovals); a click on "Encoding" shows the encoding objects (magnetic strip, smart card and contactless smart card).

The "Order" tab allows us to move the selected object in front of all the objects or under all the other objects, as the objects on a card template are beside each other, and also on or under the other ones.

Tip: by placing two text objects containing the same information shifted by 0.2 mm vertically and horizontally, then by changing their order, we may obtain a 3-D effect.

The properties pane

On the right of the window, the properties pane shows all the properties (i.e. characteristics) of the currently selected object, and, if none is selected, the properties of the current card side.
These properties are specific to each kind of object, so the contents of this pane changes each time we click on an object. To select an object, we just have to click on it. To deselect any object, we just have to click on the card background, in a place where there is no object.

The properties pane looks like this one and contains:

- At the top, the objects selector (a combo-box with a yellow background, displaying here "Card – front – 100%") allows us to select easily the object for which we want to review or change the properties,
- Two buttons allow us to display only the main properties or all the available properties of the selected object,
- The list of the properties with their respective values,
- A succinct help for the selected property in the pane.

To modify the value of a property, we just have to click on the button on the right of the property to select in a combo-box the needed value or to make a dialog box to appear. We may also use the keyboard to enter the new value, whenever it's possible to.

This guide is not intended to explain all the properties of all the object kinds, so we'll only explain some of the most used properties.

The background of our card

If we want to design a double sided card, or a non-standard sized card, or a portrait card instead of a landscape card, let's open the "Card" menu.

In this menu, we'll be able to select the size, the number of sides and the orientation of our template.

Notice that this choice will not be definitive, we'll be able to change it at any time.

Now, insert the background picture: click on the card (where there's no object): the properties pane now shows the characteristics of the card.

Click on the combo-box button for the "Background" property. Select "Choose a file". Browse your local or remote hard disks with the common "Open" dialog box and click on the "Open" button once the image found. The filename of the picture then appears in the property, and the card background now contains the picture.

The background of the card template is now defined
Please notice that eMedia Card Designer considers that the background picture is an image that must cover all the card background. To obtain the best possible printing quality, the printer manufacturers recommend a size multiple of 1016 pixels wide per 648 pixels height.

The identity picture of the card holder

Now, let's add the identity picture of the card holder. We may use one of these two objects from the toolbox for this purpose:

- The "Image" object permits the insertion of a static picture. The user in operating mode will not be able to change it. This is useful for a company logo or an invariable graphic object.

- The "Photo" object permits the insertion of a variable picture. The user in operating mode will be able to change it by selecting a picture file on disk or by acquiring the photo from a digital camera or a webcam.

As the user in operating mode will have to change the picture, click on the "Photo" object in the toolbox on the left. The corresponding object is then created in the card layout, and is also selected: height handles around it help us to move and resize the object in any direction.

A tooltip displays some additional information about the object. Click anywhere to remove this tooltip.

Now, move the picture to the location you want it to be: place the mouse pointer over the picture, click and drag the object to the correct place.

Do the same to resize the object: Click and drag any of the handles around the object. Drag the handle to the new location, and drop the handle to review the result.

If needed, we may crop the picture to keep only the interesting part. For instance, if the picture contains more than one element, and if only one of these is useful, we may focus on it.

For that purpose, press the SHIFT key on the keyboard, and while keeping this key down, move the picture. The object itself will not move, but the picture in it will move. Notice that this cropping operation can also be performed while in operating mode.

Also, to focus on a part of the picture, we may change the zoom level, and the automatic zoom feature (on by default) that adapts the zoom level to try to display and print the most part of the picture.

Let's change the AutoZoom property to false, and then change the Zoom property from 31% to 40% so we obtain a closer look to the picture.

Beware on the fact that if you change the AutoZoom and Zoom properties, all the holders' pictures will have to be similar in dimension and layout to guarantee a perfect result.
**Let's go a little bit further**

The properties pane currently displays only the most common properties. We may switch this pane to the advanced view by clicking on the "Advanced display" button on the top of the pane, close to the objects selector. All the properties of the photo objects are then displayed such as on the screen shot on the right. The "Simple display" button reverts back to the most common properties only.

We'll notice the following in the properties list:

- The "Name" property permits to give a name to the object. This will be useful later to retrieve a particular object on the card,
- The "Rotation" property is useful to print the picture in the right way, for instance if it has been shot from a digital camera in portrait mode,
- The "Legend" and "ToolTip" properties allow us to give information and help to the person who'll be in charge of printing the cards from the operating mode,
- The placement properties (values in millimeters),
- The crop properties that will allow to extract from the whole picture only the interesting part,
- The "Locked" property, which locks the object out so it's not possible to move it with the mouse anymore.

**The holder's name and other text objects**

Let's add some new information on our card template: the holder's name. For this purpose, we'll add a text object then define its properties so he'll be able to contain the information.

In the toolbox on the left, click on the text object. This one appears on the top left of the current template. Notice that for two-sided cards, the object appears on the current selected side. To ensure that the creation is made on the correct side, you have to click on the target side before clicking on the icon in the toolbox.

The display now looks like:
We'll see, under the "Properties definition" dialog box, the newly created object in its blue case.

Notice right now that this blue background is only visible in design mode, to allow you to easily select the object.

In operating mode, the texts are always on a transparent background:

<table>
<thead>
<tr>
<th>Design mode</th>
<th>Operating mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>The text is over a colored background</td>
<td>The background is now transparent</td>
</tr>
</tbody>
</table>

The "Properties definition" dialog box helps us to specify, at the creation time, the two main properties of a text object:

- **Source** defines the kind of information that this object will contain,
- **Data** defines the information itself.

The dialog box appears each time an object is created, if the box at the bottom of the dialog box is checked. The dialog box also appears when double-clicking on the object.

**The sources of the data**

Let's open the "Source of the data" combo-box and see what's in there:

- **Fixed** tells the software that the text in the object will not change in operating mode. The user will not be able to modify it. The "Data" property contains the information to display.
- **User input** tells the software that the text will be entered by the user in operating mode, from a text-box in an input window. The "Data" property contains the default value to be used if the user doesn't define the contents of the object before printing out.
- **Print counter** tells the software that the object will contain a numeric value. This value will be changed automatically each time the card is printed out. This will allow, for instance, a numeration of the cards. You may define the first value and the added value for each printout in the dialog box displayed from the "Print counter" command of the "Tools" menu. The "Data" property is unused.
- **Date and time** tells the software that the object will automatically contain the current time and/or the current date of the printout. The "Data" property is unused.
- **Expression** tells the software that the object contains a formula. This formula is calculated each time a data is entered by the user in operating mode, or when the printout occurs. The result of the calculation is then shown in the object. The "Data" property must contain the formula.
- **Database field** tells the software that the object will contain the value of a field of the current record of the database linked to the card template. The "Data" property must contain the name of the database field.
- **Choice list** tells the software that the object contains a list of possible values. In operating mode, the user will select in a combo-box one of these choices. You will enter the different possible choices from the "Data" property.
- **Database choice** is a little bit more complex, as it is the combination of the "Database field" and "Choice list" sources. This kind of source tells the software that the user in operating mode will be able to select a value from possible choices. These choices will be extracted from a second table of the database. Once a value is chosen, this value, or a foreign key, will be stored automatically in a field of the main table.
Please notice that it's not possible to use all the possible sources with a Standard Edition of the software. Some sources only work with a Professional or Expert Edition of eMedia Card Designer.

We may also check out these sources, expression, database field and database choice by enabling the demonstration mode from the "Help" menu. We also know that enabling this mode prevent the user from printing out usable cards.

In this guide, we'll only talk about simple features, as our purpose is to learn how to use the software, and not to become a software developer. If more information is needed, we may press the F1 key at any time while using eMedia Card Designer.

We'll be pleased to have the name of the card holder in this text object. As this information will be specific to each printed card, we can't use a fixed source, and must use a variable one. So, choose the "User input" source, so the user in operating mode will enter the holder's name before printing out.

Insert in the "Data" property a default value. The dialog box will then look like:

```
Entering the properties of our text object
```

Now, click on the "OK" button, then move the text object on the card so it reaches its printing position. Give it a width and a height compatible with the expected contents.

Now, let's review the available properties:

- The "Font" property will help us to change the style and the size of the font.
- The "Alignment" property will help us to tell to the software how the text must be presented in the object (left aligned, centered or right aligned).
- The "Rotation" property will help us to write in any direction.
- The "FontColor" property is useful to specify the text color.
- The "MultiLine" property allows us to write the text on more than one line.

**Presenting the information**

The "Format" property may be used to define an automatic layout mask for our text. It's very useful for numeric values or dates. The user in operating mode will then be able to enter the information as he wants and eMedia will, by itself, change the presentation of the data to fit your own specifications.
To specify a format, click on the button on the right of the "Format" property, and click on the "Choose format" choice. In the dialog box that appears then, select the data category, then the needed format. In the example on the right, as we want to force the upper case, we selected the ">" format.

If you use the Microsoft Office™ Suite, you'll find all these formats very familiar... The format strings in eMedia Card Designer are the same than those in Microsoft Excel™.

The example text-boxes at the bottom of the dialog box help you to review how the data will be presented using this format: enter a value in the "Value" text box, and see the result in the "Formatted" text-box.

**Giving some help to the user**

When this card template will be finished, maybe the person in charge of printing out the cards will not have the skills you'll have after reading this guide. So, we must give him information so he'll be able to enter the data correctly. For this purpose, two properties have been included in the properties pane:

- **Legend** is a short text, just a label, which will be displayed in operating mode in front of the text-box the user will have to fill in, so the user will be able to understand what he's expected to enter there.

- **ToolTip** is a help text which will be displayed below the text-box and in the status bar when the user will give focus to the text-box. He'll have some information about the data to be entered there.

We'll define these properties as shown on the right, so the resulting input box for the user in operating mode will look like the one displayed below:

**Exercise**

Try now to add to your card a text, rotated 90°, containing "printing on" followed by the print date. The screen shot below shows the expected result. And, if you think you're not able to do this, read the following...
There are many ways to perform this job. We'll not describe the easiest one, but we'll show you the most powerful solution.

The first thing to do is to create a text object. Sure you did find also this was the first step.

As we want to display the print date, we'll define the source property to "Date and time".

The text must be printed vertically, so we change the "Rotation" property and set it to 90.

Now, we move the object near the right border of the card, using all the available height, and set the "Alignment" property to "Center" so the text will be vertically centered.

To print out the date as needed, we'll apply a format containing the text to print out ("Printed on") and the correct date format: "mm/dd/yyyy" which means: two digits for the month, a "/" sign, two digits for the day, another "/" symbol, and the year on four digits.

The screen shot of the properties pane, on the right, shows the full set of properties defined.

You'll see that the "Legend" and "ToolTip" properties are grayed. This is due to the fact that the source of this text object is "Date and time". As the contents of the object will be defined automatically by the computer, and will not be entered by the user in operating mode, there's no need to specify any help text.

Also, to guarantee a correct position of the object on the card, we may enter by ourselves, manually from the keyboard, the four coordinates of the object, using the "Top", "Left", "Width" and "Height" properties. The values of these properties are always in millimeters.

**Let's go a little more further**

With a Professional Edition or an Expert Edition of eMedia Card Designer (or by enabling the demonstration mode), we may use more powerful features: formulas and database field contents.

As the database connection and utilization is described later in this guide, let's review now the text objects containing formulas.

You may tell eMedia Card Designer that a calculation is to be performed. You'll enter in your card design the formula to be computed and eMedia will calculate the result.

Suppose, for instance, that your card must contain its own expiration date. This one will be calculated from the start date (entered by the user in operating mode). The card will expire 90 days after this start date.

The screen shot on the right shows the properties of the text object which will contain the start date.

Set the properties as:

- **Source** is "User input" as the operator will have to enter the start date,
- **Legend** and **ToolTip** are set to useful help texts,
- **Data** contains "01/01/2000" as a default value,
- **Name** is set to "tStart" as we'll need to use this name in our formula.
You may also create two text objects, with a fixed source, containing respectively "Valid from" and "to".

Now, create a new text object for the expiration date. Set the "Source" property to "Expression": in operating mode, the user will not have to care about the expiration date; this one will be calculated automatically by eMedia Card Designer from the start date entered.

Click on the "..." button on the right of the "Data" property of this new text object to display the expression wizard:

![Expression wizard](image)

Expression wizard

Select the "Add days to a date" formula and click on "OK". The corresponding formula appears with, between the curly brackets, the data we'll have to define now.

![Visualization of the formula](image)

Visualization of the formula

As the original date is entered by the user in operating mode and stored in the "tStart" object of the card, select "In the value of a card object" and click on "OK". The wizard displays the list of the objects. Select "tStart" and click "Ok".
The wizard asks us for the number of days. As defined above, select "I'll enter the information now", click "Ok" and then enter the value: 90 and click "OK".

The complete formula is now displayed as:

\[
\text{Format(DateValue(@tStart) + "90", "Short Date")}
\]

If this formula is correct, just click "OK".

We may also click on the "Advanced" button to display the other window of the expression wizard. This window helps us to build very powerful and complex formulas, using the built-in functions.

The user interface is the following:

Our formula is displayed in the bottom area and we may modify it to add an object of the card or a function of the software by double-clicking in the two hierarchical lists above.

As the formula corresponds to our specifications, we may click on the "Check" button at the top. A message tells us that the formula is correct and will return the value.

For more information about the formulas, click on the "?" button at the top of the dialog box. A specific help will appear, containing all the needed information to build powerful formulas and the full reference about the built-in functions.

A barcode with the membership number

We may create and manage the barcode objects exactly as we did with the Text objects. In this paragraph, we'll create such an object, which will contain the member number to our tennis club.

Click on the barcode icon in the toolbox on the left (see the icon here):

The "Properties definition" dialog box appears, so we'll be able to select the source of the data and the contents of our barcode. It's the same dialog box than the one seen before.

If our barcode must contain the member number, this number must change for each new printout automatically. So we'll use a print counter. Select "Print counter" in the "Source" combo-box. The "Data" property is not useful anymore. Don't matter about it.

Click on the "OK" button.
Move the barcode object over the card to place it as shown on the right.

There is a blank background behind the barcode. Notice that this background will not disappear in operating mode (as for Text objects), as the barcode must be on a clean background to allow LED barcode readers to read it. These readers are only able to read barcodes in true black (K ribbon) over a background that has a constant luminosity level. We may choose any other color than the white for the background, but transparency is not allowed. We may also choose a "Masked" background. In this case, the background will be printed in composite black. A copier will not be able to make a difference between the composite black and the barcode true black, but the reader will be able to. It's a way to enhance the card security.

Let's review now the main properties of the barcode object we created. We'll not describe again the properties seen for the text objects, but only the new ones and those which don't have the same purpose:

- The "Font" property is to be used to select the barcode type to use.
- The "BarWidth" property defines the width of the black bars. It's a number. As this number increases, the bars are wider. The value 0 (zero) tells the software to use an automatically calculated value. The width of the bars will then depend on the number of bars to draw and on the width of the object itself.
- The "Direction" property indicates the reading direction. You may choose 0°, 90°, 180° or 270°
- The "ValueVisible" property defines that the value of the barcode must be written below the bars. If this property is set to "True", then the "ValueFont" property defines the characteristics of the font used to write this value.
- The "Notches" property indicates if longer bars must be printed at the left and the right of the barcode (for barcode types that support this feature).

**Characteristics of the print counter**

When a print counter is defined in a card template, its default value is set to one, and 1 is added to this value each time a printout is performed. To change the default value and/or the value added at each printout, we may configure the counter, from the "Print counter" command of the "Tools" menu.

The following dialog box appears:

The "Initial value" text-box contains the value to be printed on the first card. Here, we consider that the first member will have the value 123.

The "Increment" text-box contains the value that will be added to the counter once the printout performed.

The "Digits" text-box defines that the counter must contain x digits. The counter value will be truncated if needed.

The "Keep zeros" check box defines, if checked, that the counter must always have the number of digits entered in the "Digits" text-box, and to eventually add zeroes on the left of the value.

There's a preview at the bottom of the dialog box to review how the counter will look like on the first printed card.
The magnetic strip

If we need to encode information on the magnetic strip, a wizard has been designed to help us creating the corresponding formula, as the magnetic strip is considered by eMedia Card Designer as an object, having its "Source" property set to "Expression". So, we have to enter in it a formula.

To specify the contents of the magnetic strip, just click on the "Encoding" tab in the toolbar.

Once the tab opened, click on the "Magnetic strip" icon (see the corresponding icon on the right).

The magnetic strip encoding dialog box appears:

Te radio buttons at the top allow us to select the type of encoding to perform:

- **ISO**: the encoding will be compliant to the ISO standards. eMedia Card Designer will check out the data to encode.
- **Non ISO**: the encoding will not be compliant to the ISO standards, eMedia Card Designer will not check out the data to encode.
- **JIS Type II**: the encoding will be compliant with the Japanese standard.

The three text-boxes allow us to enter the three formulas (one for each track) or the only formula for the single track on the front side of the card if "JIS Type II" was selected.

Each text-box must contain a formula, and this formula must return a string, having the max length specified under the text-box. The return value must also contain either only digits (numeric only tracks) or digits, characters and some symbols (alphanumeric tracks).

During the encoding phase, any data that will not correspond to the ISO standards (for ISO encoding), will be replaced by eMedia Card Designer by space characters, or will be removed on numeric tracks.

Two buttons on the right of each text-box, display dialog boxes helping us to define the contents of the track:

- This button opens the "Expression wizard" dialog box seen previously. This dialog box will help us to create and test the formula.
- This button opens a wizard that will allow us to build the contents of the track on a step-by-step basis. At each step, we'll be asked if we want to add or concatenate objects of the card, fields of the database, fixed data, etc.
Let's use this button now to call the magnetic strip wizard. We'll define in it, one at a time, the elements that will be concatenated on the track. We'll be able to review the formula later, using the Expression wizard (first button on the right of the track contents) for instance to enhance it with new calculations.

Click on the button on which is drawn a magic hat. The following dialog box appears:

![Magnetic Strip Wizard](image)

**Magnetic strip wizard**

Click on "Next" and begin the configuration of the track. We'll suppose, for this demonstration, that our track will have to contain the holder's name, the start and end dates of membership and the print date, all these data separated with the normalized separator character for ISO track 1: "^".

The dialog box displays the first step, in which we must choose where is located the data used for encoding: in an object of the card, in the database (if a database is linked to the template), to be asked to the user, or a fixed data.

Select "A data that is on the card" and click "Next". As the holder's name will be located in the text object named "tName", select this object and click "Next".

At the first step, the dialog box asks us if we want to concatenate or to add:
Concatenate means: "add a data without separation". Add means: "add another data but as it must be done on a magnetic strip, e.g. with the ISO separator character between them".

So, click on "Add another text or value" and click "Next", to continue at the first step: what kind of information, then the information itself, etc.

If we forget what are the data already inserted, we may click on the "Preview" button of the dialog box. Two text-boxes appear then at the bottom, showing the formula we are building and a preview of its contents:

Once all the data inserted, select "Terminate" at the third step, instead of "Concatenate" or "Add" and click the "Next" button. The dialog box disappears and the formula is now shown in the text-box of the selected track. Now, click "OK", and your encoding is ready.

Please notice that if you're using a two-sided template, the magnetic strip is now visible on the back side to avoid the designer to create objects at this place.

---

**Connection to a database**

With the Professional and Expert editions of the software (and with the demonstration mode), your card template can be linked to any database using either an OLEDB or an ODBC driver. This gives access to the whole possibilities of storing and managing large amount of data.

The Standard edition of eMedia Card Designer only allows you to connect to a Microsoft Excel™ datasheet. This solution is limited as these datasheets don't offer all the features of a database, but this allows you to manage a simple set of data.

**Defining the database connection**

In the "Tools" menu, select the "Database connection" command:
With the Professional and Expert editions and with the demonstration mode enabled, all the choices are enabled. With the Standard edition of the software, only the "Microsoft Excel worksheet" choice is enabled.

Now, either you already have a database and want to connect to it, either you don't have any database and want to create one.

- If you already have a database, click on the radio button that correspond to the database type and click "Next". The following pages will help you to select your database and to configure the way to connect to it.

- If you don't have any database, or if you want to create one, click on the "Create database" button. The wizard will help you to define the fields: names, types and lengths. The created database will be saved using the Microsoft Access™ format and the current card template will be automatically connected to this database.

To add, modify or delete fields, just click on them in the grid with the right mouse button and select the corresponding command in the popup menu.

Once the structure of the database defined, according to your needs, the wizard will ask you for a filename in which the database will be created.

We'll now connect to the sample database provided with eMedia Card Designer. In the dialog box in which the type of the database is requested, click on "Microsoft Jet engine (MS-Access 2000)" and click on "Next".

The wizard asks for the name of the database file. Click on the "..." button and select the "Company.mdb" database located in the samples folder, in: "Color printer – English\Enhanced cards\Company Cards". Click on "Open" to select this database, then on "Next":

In this step, we'll enter (if needed) the user ID and the password to provide to the DBMS if the connection needs an authentication. It's not the case for our example.
Please notice the "Test connection" button. Its role is not to verify if it is possible to connect to the database, but only to verify that all the software components and drivers are installed on the computer to make the connection possible.

Database connection – Source of the data

After having clicked "Next", the next step appears, in which we’ll select the kind of data source we need in the database:

- **Table**: one of the tables of the database, and all the records stored in it.
- **View**: a set of records from one or many tables. It's called a "Request" in Microsoft Access™ or a "Stored procedure" in Microsoft SQL Server™ or Oracle™.
- **SQL Statement**: You'll be able to enter a SQL SELECT command in a text-box. For more information, please refer to the online help or your SQL documentation.

With the "Cursor type" combo-box, you’ll be able to choose between a **Keyset** cursor and a **Dynamic** cursor.

Click on "Next" to display the next step. The list of table or views appears. Select yours. Or, a text-box waits for your SQL statement, enter yours:
The next step allows us to define if the user in operating mode will have the possibility to modify records, add new ones or delete existing records (and, in this case, if the photo picture files will be also deleted).

The two next steps are very similar: a list of fields is shown, and each can be selected or not:

But these two steps are not identical:

- In the first list, you select the fields which will be displayed to the user in operating mode (so you are able to hide certain fields).
- In the second list, you select the fields that the user will be able to modify, if the authorizations were set in the previous step (so you are able to lock certain fields).

Click "Next", then define a sort order for the records.

Click "Next" again, and the dialog box let you define how to map the photo object(s) to the photo field(s) of the database:
Some database types can store pictures or binary objects. Other just can’t. So, to be coherent, the software only stores in the database the file name and path of the picture stored on disk.

In this step, we'll associate to the Photo and Image objects the fields of the database which contain the picture path and filenames.

To do so, select in the "Card objects" combo-box the name of the object on the card, and in the "Database field" combo-box the corresponding field of the database. Then click on "Add/Remove" to create the association.

If we didn't create a photo object before calling the wizard, we may select "Create a new object". eMedia will create a photo object for us.

And, if we want to remove all the associations defined, we may click on the "Delete all" button. We’ll have to confirm the deletion.

Click on "Next" to gain access to the last step, in which we may review the selected records. By clicking on the "Preview records" button, the dialog box on the right is shown:

This window will be displayable at any time by pressing the F3 function key. If the "1000" box at the bottom is checked, only the first 1000 records are shown (this is useful for remote DBMS to avoid latency).

**Defining the link between the objects and the fields**

When we defined the connection to the database, we did associate the Image and Photo objects to database fields, for the pictures handling. We'll now do the same with the Text and Barcode objects.

To do so, we just have to change the value of the "Source" property, by setting it to one of these two possible values:

- **Database field**: the text or barcode object will contain the value of one of the fields of the database for the current record. The name of the corresponding field will be set in the "Data" property.

- **Database choice**: the text or barcode object will contain the value of one of the fields of the database for the current record, and this value will be one of those defined in a second table. We’ll see how to configure this later in this chapter.

Select now the tName object on our card template, which will contain the last name of the holder. Modify the "Source" property and set it to "Database field". The "Data" property is now a combo-box. Open it and select the "Last Name" database field:

Do the same for the barcode (object bMemberNumber), and set it to the "EmployeeID" database field.
Formulas and database fields

To enhance the overall performances of the application and the template, we may combine the formulas with the database fields.

Suppose, for instance, that the tName card object has been designed to hold the full name of the holder.

But the first and last names of the holders are in two different fields of the database...

Impossible? Nothing's impossible. Use the expression wizard to create a formula that concatenates two texts (such as a first and last name). And, instead of concatenating two objects of the card, ask the wizard to concatenate two database fields. Your tName object will then have the following characteristics:

- **Source**: Expression
- **Data**: DBField("First name") & " " & DBField("Last name")

eMedia Card Designer helps you to gain access to your own database, but also helps you to manage your data in order to print them out on the cards in the most coherent way.

Let's go further with the "Database choice"

By setting the "Source" property of a text or barcode object to the "Database choice" value, we'll help the user in operating mode to enter a value in the field, by selecting the correct one into a list of possible values.

For instance...

Our Tennis club makes offers to companies in its neighborhood special prices and specific access times. So, our card must handle and information that shows if the holder depends on one of these companies, or if it's an independent member.

Let's define this solution...

For the "Database choice" source, we need another table in the database, containing all the possible values. So, in our database, we create a new table, named "MEMBER_TYPES", containing the following records:

<table>
<thead>
<tr>
<th>MEMBER_TYPES</th>
<th>TYPE_ID</th>
<th>TYPE_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Single member</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>ACME Comp. employee</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Rible Corp. employee</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Rassie Ltd employee</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Pacap Corp. employee</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Deutaite Ltd employee</td>
</tr>
</tbody>
</table>

Also, we modify our main table, and insert in it a field that will contain the company in which the member works.

<table>
<thead>
<tr>
<th>EMPLOYEES</th>
<th>EmployeeID</th>
<th>Last name</th>
<th>First name</th>
<th>MEMBER_TYPE</th>
<th>Job title</th>
</tr>
</thead>
<tbody>
<tr>
<td>250002</td>
<td>SMITH</td>
<td>John</td>
<td></td>
<td></td>
<td>Manager</td>
</tr>
<tr>
<td>251356</td>
<td>CLEMENTINE</td>
<td>Sarah</td>
<td></td>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td>254234</td>
<td>ARDELLO</td>
<td>James</td>
<td>3</td>
<td></td>
<td>Manager</td>
</tr>
<tr>
<td>256057</td>
<td>DEPRES</td>
<td>Norbert</td>
<td></td>
<td></td>
<td>Manager</td>
</tr>
<tr>
<td>256889</td>
<td>MILLER</td>
<td>Michael</td>
<td>4</td>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td>256891</td>
<td>WALTER</td>
<td>Soline</td>
<td></td>
<td></td>
<td>Employee</td>
</tr>
<tr>
<td>257023</td>
<td>LAPAUTREMAT</td>
<td>Stephan</td>
<td>1</td>
<td></td>
<td>Assistant</td>
</tr>
</tbody>
</table>

We may also define the company of the employees. Here, for instance, James ARDELLO works in Rible Corp.

We have now to define an object on the card template, having its "Source" property set to "Database choice", then we click on the button on the right of the "Data" property to define
what will this object contain in operating mode, where the data will be extracted from, and what kind of data will be stored. The following dialog box appears:

![Database choice dialog box]

With these settings, in operating mode, the input window will contain a combo-box filled in with all the possible values of the TYPE_NAME field of the MEMBER_TYPES database table.

When the user will select one of these values and will save the record, the selected information will also be saved in the MEMBER_TYPE field of the main table, and the value will be the contents of the TYPE_ID field of the record that correspond to the value selected.

The result of such a configuration is shown in the window on the right. The combo-box contains all the possible values of the TYPE_NAME field. When the record will be saved, the MEMBER_TYPE field for Mr. SMITH will contain the value corresponding to "ACME Comp. employee": 2.

Why 2?

In the MEMBER_TYPES table, for the record "ACME Comp. employee", the TYPE_ID field contains... 2.

*More and more further...*

Our card template now holds a text object in which the member type is displayed, for instance "ACME Comp. employee" for Mr. John SMITH.

Now, suppose that we don't want the full company name, but just "CE" (for Company Employee) that displays if the holder relates to a company or not.

How may we do that?
Try to realize this exercise by yourself, and if you can't do it... read the following, which may be one of the possible solutions (but not the only solution).

Solution

We'll hide the text object containing the member type and will create another text object, in which we'll set the following formula:

*If the MEMBER_TYPE field of the database contains the value 1 (associated to "Single member"), then the formula will return ",", otherwise the formula will return "CE".*

This formula is the following:

\[
\text{IIf(DBField("MEMBER_TYPE") = 1, ",", "CE")}
\]

Change the font, the size, the color, etc of the text object so he'll look nice, and move it on the card at the location you wish.

Let's put the finishing touches

Of course, we saved our template from times to times. And, if our template must be used by many users, we saved it on a network resource.

But now, if we want to lock the template so the users will not be able to modify it, how may we do that?

Of course, we may change the ACLs of the hard disk file, but this will not prevent the card from being modified by a user...

So, we are able to lock out the card template from eMedia Card Designer by assigning to it a password. To do so, open the "Edit" menu of the software and select the "Set password" command. The following dialog box appears:

![Passwords definition dialog box](image)

You may define two passwords, and for each, you must enter the password two times (to avoid keyboard errors).

- The first password locks the access to the design mode for this template. The user will have to enter the password to be able to open it in design mode. Of course, the user will not have to enter any password to print out cards from the operating mode. So, only designers will have the ability to modify the contents of a card template.
- The second password locks completely the card. The user will have to enter the password to open it in design mode and also in operating mode. The card is restricted only to the people that know this password.
3. THE OPERATING MODE

The operating mode is intended to be used for printing cards out and/or to encode cards (magnetic strips, smart card and contactless smart cards) from one of the templates already created in design mode.

The operating mode doesn't need any particular skill (the user must also be able to use a mouse and a keyboard). In this mode, the user will only have to enter data from the keyboard (for instance the name, the company, etc of the holder) and to click on buttons to select data and to print the card out.

Launching eMedia Card Designer in operating mode

eMedia Card Designer may be launched from the "Start" menu, "All programs" command. The icon located on the desktop may also be used.

If eMedia Card Designer was already launched in design mode, you may switch to the operating mode by clicking on the first toolbar button (the second button switches you back to the design mode). You may also use the two first commands of the "View" menu.

It's also possible to start the software and load a card template in a single operation. To do this, just create a shortcut to a card template file.

The main window of the software in operating mode looks like this one:

This window mainly holds the following elements:

- The **Menus bar**, which gives access to the software functionalities.
- The **Tool bar**, which gives access to the main functions.
- The **card preview**, in which you may see at any time the card as it will be printed.
- The **input window**, which allows us to enter information relative to the current card and/or relative to the current record of the database.
- The **tool bar of the input window**, which helps us to move between records, to create, modify or delete the current record, to search record(s), etc.
- The **status bar**, which displays information about the location in the database and about the information to enter in the input window.

At launch time, no card template is opened (unless a card template has been asked for): the preview contains a blank card and the input window is empty. We must open a card template.
Opening a card template

To print a card out, we must first open a template that contains the graphical design of the card and the encoding information.

To do so, select the "Open" command in the "File" menu, or in the tool bar, click on the "Open template" button (the third one). A "file open" dialog box appears. In this one, select the card template file you want the software to load in memory and click on the "Open" button.

This card template may be locked out with a password. In this case, the dialog box on the right appears. Enter the correct password in the yellow text-box (this password was delivered to you by the card designer or the administrator) and click OK. If you don't know the password, click on "Cancel", accept the error message and try to open another card template.

Once the template opened, you just have to enter the needed information in the input window and to print the card out.

The input window

In this window, you'll enter the data to be printed on the card. You'll also enter database information if the card template is linked to a database. In this case, the tool bar of the window will help you. The tool bar contains buttons only enabled if the card is linked to a database:

- **Refresh the records**
  This button tells the database server to resend all the data.

- **Refresh the current record**
  This button tells the database server to resend the current record.

- **Display the records in a grid**
  This button opens a window containing a grid with all the database records.

- **Display the first record**
  This button moves to the first record. The input window and the card are updated.

- **Display the previous record**
  This button moves to the previous record. The input window and the card are updated.

- **Display the next record**
  This button moves to the next record. The input window and the card are updated.

- **Display the last record**
  This button moves to the last record. The input window and the card are updated.

- **Search one or many records**
  This button opens a dialog box allowing us to search for records then print them.

- **Create a new record**
  This button empties all the text-boxes and prepares the display for a new record.

- **Modify the current record**
  This button allows us to change the data of the currently displayed record.

- **Delete the current record**
  This button deletes the current record (a confirmation is requested).
Under the tool bar, the data are located in fields defined as a label and an input box. This one may look like the following:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEGAL</td>
<td>A grayed out box can’t be modified.</td>
</tr>
<tr>
<td>LEGAL</td>
<td>A yellow box may be modified. Click on it to place the cursor, or use the TAB key to move from boxes to boxes.</td>
</tr>
<tr>
<td>LEGAL</td>
<td>The orange box is the enabled one. Data entered from the keyboard appear in it.</td>
</tr>
<tr>
<td>ACME Comp. employee</td>
<td>Some boxes may have a button on the right. Clicking on it makes a list to appear. This list contains the allowed choices for the box.</td>
</tr>
<tr>
<td>Single member</td>
<td>Select in the list the choice you want, then click on it. The list disappears and the selection made is now in the box.</td>
</tr>
<tr>
<td>Ribble Corp. employee</td>
<td>This kind of combo-box allows faster and easier inputs than having to use the keyboard.</td>
</tr>
<tr>
<td>Rassie Ltd employee</td>
<td>For images, identity pictures, signs, etc that may be modified, the input box contains a list (as seen above) and a button with a camera on it.</td>
</tr>
<tr>
<td>Pacap Corp. employee</td>
<td>The list contains choices for managing the picture: selection of an acquisition device, loading a new picture from disk, access to a dialog box for changing the zoom level and the rotation angle, calling an external program for image modification.</td>
</tr>
<tr>
<td>Deutate Ltd employee</td>
<td>The button start a picture acquisition from the currently selected digital camera or webcam, using its Twain or WIA driver.</td>
</tr>
</tbody>
</table>

At the bottom of the input window, two buttons can be clicked to print the card and to clear the input box to begin a new card. These buttons are also present on the mail tool bar.

**Image acquisition**

To acquire a picture, just click on the button with a camera on it. The user interface of the manufacturer of your camera or webcam appears on the screen (if your device has been correctly installed). Acquire your picture. Once performed, the window closes and the picture is transferred in the image or photo object in the card.

If, when you click on the button with a camera in eMedia, the user interface that appears is not the one that corresponds to the device you want to use, cancel the acquisition, and select “Acquisition source” in the combo-box. The dialog box that appears then helps you to select the correct device.

**Using a database**

When the data of your card are stored in a database, the buttons of the tool bar of the input window are enabled.

Two of them have special meanings that require an explanation. These buttons are the "Display records" button and the "Find record" button.

**The data grid**

Click on the third button of the tool bar of the input window ("Display records"). A new window appears, in which the contents of the database is displayed. This window can be used
for two purposes: it allows you to review the whole database contents (use the scroll bars on the right and below the grid), and it also allows you to display the card that corresponds to a particular record: just double-click on the corresponding record.

This window doesn't display all the records of the database (because it may require a large amount of time to display many many records located on a database server very far away from your computer), but only the first 1,000 records. If you want to display all the records, then uncheck the box at the bottom of the dialog box. Don't be surprised if the refreshment of the grid may require a very very long time, then. This window may be kept opened. It doesn't prevent the software from running.

But, sometimes, the window may be desynchronized from the database (because other user may have changed some record contents). New records may be invisible, for instance. You may then click on the "Refresh" button to resolve the issue.

Finding records

For searching records, a window appears when you click on the corresponding button of the tool bar of the input window (the one with the magnifying glass). This window allows the search of records using four different methods: search of a value, utilization of a SQL filter, search of a range of values, search by record number.

This windows also allows you to perform batch printing, e.g. to print out in a single pass all the records selected by the search options.

Search of a value

This is the default mode. When you click on the tool bar button, the window on the right appears.

Just select in the combo-box the name of the field on which to search, and below the value to search for.

Once these two informations entered, use the four arrow buttons on the bottom left of the window to display in the eMedia main window the first, previous, next and last record respectively. If no record can be found, or if no more records can be found, a beep will be heard.

Search with a SQL filter

Click on the "Advanced" button at the top of the window to be able to search from a SQL filter. The window looks like:

This search mode requires some skills in SQL language to be able to enter a filter without syntax errors.

Enter in the text-box in the middle of the window the filter clause of a SQL statement (i.e. the WHERE clause of a SELECT command). Then, as described previously, use the four arrow buttons to review first, previous, next and last record that correspond to this filter.
Search in a value range

The search mode is very useful when you don’t know the exact value to search, as you are here able to ask the software to find all the values between a mini and a maxi.

Click on the "Field range" button to display the following:

Select the database field in the combo-box and enter in the two text-boxes the range of values (mini and maxi values) to search for in the field. All records having in this field a value between the two ones entered will be selected.

As previously described, use the four arrow buttons at the bottom of the window to display in the eMedia Card Designer main window the first, previous, next and last records.

Search by record numbers

This search mode may only be used with DBMS that supports book marking, and for which numbers may be assigned to records. It allows you to select many records between two of them, so you are able, for instance, to request the first ten records (from #1 to #10).

Click on the "Record range" button to show the following:

Enter then in the two text-boxes the numbers of the first record to display and of the last record to display.

As before, use the buttons at the bottom left of the window to display in the main window of eMedia Card Designer the first, previous, next and last record of the selection.

Batch printing

Batch printing means: printing a set of records based on a common template (similar graphics and electric personalization) and on common data (having similarities).

To perform a batch printing, you must first select the records that will be printed out. For this purpose, as explained in the previous paragraph, you’ll search for records. You may use any of the search features described above: search of a value, with a SQL filter, in a value range, by record numbers.

Once the records you want to print selected, just click on the button holding a printer icon at the bottom right of the dialog box, and the cards will be printed, one for each record.

Don’t forget to feed the printer with a sufficient number of blank cards, or feed your printer from times to times.

Remember: it’s not a good idea to print large amount of cards in a single operation. If eMedia Card Designer can handle large amount of copies, the printer has its own limits: the capacity of the card charger, or the ribbon which has an end and the printing head that must be cleaned once a certain amount of copies is reached.

During a batch printing, in case of emergency, you may, at any time, click the “Abort” button of the print dialog box to stop immediately any printing operation from the software. Don’t forget in this case to also cancel the print jobs in the printer queue.
**CoolReader™**

CoolReader is a technology that allows the user in operating mode to retrieve instantly a printed card from the data stored in the database and from the physically printed card, by reading a barcode value, the contents of a track of the magnetic stripe or the Mifare serial number.

CoolReader requires a Professional edition of eMedia Card Designer, or an Expert edition to be able to retrieve a record from the Mifare serial number.

This allows, for instance, the display on screen of the card that corresponds to the one inserted in a reader. In a visitor’s management software, this would be useful for validation of the holder or when the visitor will leave the company, to enter in the database the current exit date and time.

To use CoolReader, the workstation must be connected to one of the following devices:

- A keyboard
- A barcode reader connected to a keyboard,
- A barcode reader connected to a serial port,
- A magnetic strip reader connected to the keyboard,
- A magnetic strip reader connected to a serial port,
- Mifare Contactless smart card reader for Classic (1KB / 4KB) or Ultralight Mifare cards. You must also have an Expert Edition of the software.

You must first configure CoolReader to define what is to be scanned, and what is the field of the database in which the search must be performed. This will be described below.

To use CoolReader, you may use any of the following:

- Press the F2 function key of the keyboard,
- Click on the "CoolReader" button in the tool bar on the top,
- Select in the "View" menu the "CoolReader" → "Show" command.

The following dialog box appears then in the main window of eMedia Card Designer. You may now scan a card or enter the card number with the keyboard.

Use the magnetic strip reader, the barcode reader or the Mifare card reader. The information read appears briefly in the CoolReader window, then this one tries to find in the database linked to the current card template the corresponding value.

If this value can be found, the corresponding card is displayed on screen. Otherwise, a beep can be heard. This beep means that the record couldn't be found or that the value couldn't be read correctly.

Once the card displayed on screen, you just have now to modify the record, to compare the card on screen to the one under the reader, to print a new card, to delete the record, etc... As you need.

**Configure CoolReader**

This configuration step must be done only one time for each card template. Once the CoolReader options set, these options will remain unchanged.

To do so, open the "Tools" menu and select "CoolReader preferences". The options window appears, and the categories list on the left allows the selection of the different parameters.

The CoolReader options are at the bottom of the categories list, and contain three pages: "preferences" to define the devices to use, "Barcode/magnetic" to configure how the data must be filtered and "contactless" to select the database record in which the Mifare serial number is stored.

A fourth page allows us to configure the magnetic stripe reader connected to a serial port.
Click on "Preferences" in the categories list to specify what devices must be used by CoolReader. The following page appears:

### CoolReader: devices configuration

Check the boxes that correspond to the devices that CoolReader will use. The first choice (keyboard port) can't be disabled.

- **Read a barcode or the magnetic strip from the keyboard port** allows CoolReader to use any device connected to the keyboard port of the computer. It also allows the direct entry of the card number from the keyboard.

- **Read a barcode or the magnetic strip from a device connected to a communication port** allows CoolReader to use any device connected to a communication port (typically a barcode or magnetic strip reader, but it can be any reader able to send data through this port).

- **Read the Manufacturer Code of a Contactless card, using the default Contactless encoding device** allows CoolReader to use the encoding device to read Mifare serial numbers. You must have an Expert license of eMedia Card Designer to use this feature.

If you enable the use of a communication port, the "Communication port settings" button display the dialog box on the right, which is intended to help you to configure the communications settings.

The data to enter in this dialog box must be identical to the one specified in your reader technical documentation. Please refer to this documentation.

The "COM Port" combo-box specifies on which port the device has been connected.

Bits per second, parity, data bits, stop bits, flow control, DTR and RTS must be set exactly as they are on the device, on the data sent by the reader will not be readable by the computer.

The "Defaults" button set these values to the default ones.
Click on "Barcode/magnetic" category if you're using a barcode reader or a magnetic strip reader with CoolReader. The following page appears:

![CoolReader: barcode and magnetic strip configuration](image)

This page allows you to define where does the data begin and end on the magnetic strip or in the barcode value. Due to the amount of information you can store on a magnetic strip, the required value (typically the card number) may be concatenated to other values (for instance by the card holder's name and other identifiers).

The "start sequences" define a series of characters that may help CoolReader to know where the interesting value begins,

The "end sequences" define a series of characters that may help CoolReader to know where the interesting value ends.

When a magnetic strip is read by CoolReader, this one "tries" all the possible combinations of start and end sequences to try to isolate something.

In the example below, the card number is located after a track separator character followed by the characters "NO", and before another track separator:

**SMITH^JOHN^NO 12312^3RD FLOOR ^PHONE 12**

Enter as begin sequence: "^NO" and as end sequence: "^"

But, you may be warned that sometimes the information will not be found if incorrect sequences are entered. Please consider the card containing the following data:

**ALLISTER^NORBERT^NO 25341^2ND FLOOR ^PHONE 24**

CoolReader will not find the record in the database. Why? See below, the solution is in red:

**ALLISTER^NORBERT^NO 25341^2ND FLOOR ^PHONE 24**

In this example, "^NO" is found at the beginning of the first name, and this first name is followed by a separator. So the included information, "NORBERT" will be searched in the database by CoolReader.

You must choose your start and end sequences very carefully to avoid this.

The "CoolReader timer" text-box defines an amount of time after receiving the last character for considering the data as complete. After this amount of time elapsed, CoolReader tries to locate the data in the buffer between the begin and end sequences. 500 milliseconds is the default value. You may change this depending on the performances of the computer, the reader and the settings of the communication port.
The "Database field" combo-box defines the name of the field of the database in which the value found (between the start and end sequences) must be found. Of course, this information is specific to the current card template.

Once CoolReader will have extracted the useful information from the keyboard or the serial port, the data between the start and end sequences, CoolReader will search this value in the database field defined in this combo-box. If the value is found, the corresponding record will become the current record and will be displayed on screen. Otherwise a beep will be heard.

Click on the "Contactless" category in the list on the left if you have, and want to use, an encoder/reader of Mifare Classic or Ultralight cards. You must also have registered an Expert edition of the software. And the serial number of the cards printer must have been stored in the database. Then, the page looks like:

![CoolReader: contactless configuration](image)

Select in the "Database field" combo-box the name of the field of the database which currently contains the serial number of the printed card. This information is specific to the current card template.

Specify in the "Storage model" combo-box how is the data stored in the field: most significant byte first or last. This information must have been defined when you did perform the configuration of the contactless encoding.

**Printing the card out**

Once the data entered and displayed on screen, we can print the resulting card out. You may perform this operation in four ways:

- The "Print" button at the bottom of the input window,
- The "Print" button in the tool bar on the top,
- The keyboard shortcut Ctrl+P,
- The "Print" command of the "File" menu.

Notice that the "File" menu allows supplemental operations, or partial operations. The other ways to print can be considered as the "Print all" command.

From the "File" menu, you’ll be able, for instance, to print out only the front side, or the back side, or to perform only the encodings.
The "File" menu will also allow you to:

- configure the default printer, from the "Print setup" command. eMedia Card Designer doesn't use the default printer of the workstation, but uses its own default printer (because the card printer is not often the default printer!)

- preview the data that will be printed and encoded on the card (for instance to preview the data that will be stored in the magnetic strip).

- Specify a number of times a card will be printed: if you can enter a number of copies from the printer preferences dialog box, these copies will be strictly identical, including the value of the print counter and even the value of the Mifare serial number! To avoid this, you may use the "Print count" command. With this one, the print counter will change between each card and the Mifare serial number will be read on each card. Be aware that specifying a number $n$ of copies from the device preferences and $p$ copies from this menu command, you'll obtain $n \times p$ cards.

You may also control the printout of the front and the back side of the card from data located on the card and from data in the database. But, as this is advanced features not covered by the current document, please refer to the online help, or contact our technical support from the internet web site:

http://www.emedia-cards.com

or by e-mail to:

support@emedia-cards.com.
4. REGISTERING YOUR SOFTWARE COPY

eMedia Card Designer contains an activation technology which is intended to avoid illegal copies. The registration is an interactive form of the license contract between you, the user, and Mediasoft Technologies. It protects the intellectual property and allows innovation which are the two main aspects of the computer industry.

The registration enables the advanced features of the software, as this one, during its installation on the workstation, already contains all the elements of the Professional and Expert edition, elements disabled by default.

eMedia Card Designer requested thousands of hours of work and request every day new modifications, developments, testing and debugging. The success of the software is due to its qualities but also to your support and your ideas. Our goal is to keep the software as close as possible to your needs and to technological standards in the plastic card domain. Today, more than 80% of the added features have been developed to respond to your requests.

Many software developers, technicians and debuggers are involved in the building process to add and modify the software, and all of us are only paid with the activations performed. We have to find the right price to remunerate us while keeping a low price for the customer. That's why we make all our possible to avoid piracy.

We did also try to make the activation process as simple as possible so it's easy for regular customers to obtain a license, while it's discouraging for the other.

To do so, the activation and registration of your software copy may be performed from the internet, 24 hours a day, 7 days a week. By providing your installation key and a second key, our license server sends you the Activation Key needed to unlock your software copy.

Principle of the software keys

The activation of eMedia Card Designer is based on a two keys system. And, to allow our customers to perform the registration at any time easily, two additional keys may be used.

The Installation Key

While installing your software copy on the computer, a unique key is generated from information in your workstation. The key doesn't contain any personal information. This key is unique. On two identical computers, installed at the same time, the keys are different.

An Installation Key is a string of 20 alphanumeric characters, beginning with "IK", as for instance:

IK-6KC5V-X0X36-EW1PE

The Installation Key identifies your own software copy.

The Activation Key

When you perform the registration, our license server computes the Activation Key that unlocks the features of the software corresponding to the license you purchased.

The Activation Key corresponds uniquely to the Installation Key on your computer: the Activation Key is unique and only works with your Installation Key.

An Activation Key is a string of 20 alphanumeric characters, beginning with "AK", as for instance:

AK-E86CN-GJ5XB-JPDXC

The Activation Key gives access to the advanced features of your software copy.
**The License Key**

This key may be considered as the "proof of purchase" of a software license. It allows our license server to deliver to you, at any time, your Activation Key. This License Key is sent to you by your local reseller.

A License Key is a string of variable length, beginning with "LK", as for instance:

**LK-MEDS-X1232-56343-34432**

A License Key is unique and may be used only once.

**The Migration Key**

At any time, you may want to move your Professional or Expert license from a computer to another one. So you'll have to uninstall the software and to bring the license on the other computer.

You may also have to reformat the hard disk on your workstation, or have to upgrade the Operating System. As these operations may delete the Activation Key on the computer, you'll need to extract the license from the computer to be able to put it again after the upgrade.

For these purposes, the Migration Key has been developed. This one is provided to you while uninstalling the software. You'll send this key to our license server (exactly as you did the first time with the License Key) to obtain a new Activation Key.

The Migration Key is a string of 20 alphanumeric characters beginning with "MK", as for instance:

**MK-X4FCV-23DFV-1D5GV**

As for License Keys, the Migration Keys can only be used once.

**Let's activate our software copy**

We just installed eMedia Card Designer and we want to gain access to the advanced features. We bought an Expert license and our local reseller provided us with a License Key.

In eMedia Card Designer, open the "Help" menu and select the "Register your license" command. The following dialog box appears:
This window presents the informations corresponding to your license and the Installation Key. Check that now, the personal informations are unknown.

Click on the "Register now..." button at the bottom. The following dialog box appears:

![License Registration dialog box]

Enter in the "Second key" text-box the License Key sent to you by your reseller. Please notice that this text-box is not labeled "License Key" as you may enter in it an Activation Key or a Migration Key.

Click on "Next". As this copy of eMedia Card Designer has never been registered, the following dialog box appears. Enter in it your personal information:

![License Registration dialog box](blank)

Please notice that the Law specifies that the license is a contract between the software editor, Mediasoft Technologies, and the final user, you. So this dialog box must be filled in with the end user (the final buyer) information.
These informations will be stored in a highly secure way on our servers and will not be provided to any third party without the express authorization of the user.

They are stored for support needs only, in the case you contact us. They will also be used for sales statistics.

Please notice that the e-mail address entered in this dialog box must be a valid address and must be checked twice before validating the form, as the Activation Key will be sent to this address by e-mail.

Making a mistake in this address will result in an Activation Key not sent and/or not received.

However, you may at any time contact our technical support department for any problem that relates to the activation and/or the keys, as our support team receives a copy of every message sent by our license server. A message not delivered to you (wrong address for instance) can be transferred, by this way, to the correct address.

Please also check out your anti-spam software to avoid any deletion, quarantine, or rejection of the message sent by our license server. To do so, add a rule that will consider as regular any message sent by a SMTP server from the "suptel.net" domain with a sender from the "emedia-cards.com".

A "reference" text-box allows you to note any additional information that relates to this license (as an order number for instance).

The check-boxes allow us (if checked):

- To provide your personal information to third parties so they'll be able to send you commercial offers (this box is unchecked by default),
- To send to you periodically the eMedia Card Designer newsletter.

Once the data entered, click on "Next". The following dialog box appears:

As the other steps of the procedure are performed on the internet, the software requests your authorization to connect to our server. You may then:

- Accept to connect to our web server to continue the procedure.
- Refuse to connect to our web server. In this case, the data will be saved in a file on your hard disk. You'll be able to copy this file on a CD or an USB key. You'll double-click on it to connect to the internet and continue the procedure.
To avoid having to reenter the data in eMedia Card Designer, all the informations entered are stored in an internet shortcut on your hard disk, in the eMedia installation folder. Double-click on it to requery the key to our internet web server.

Once the data sent to our internet web server, the following appears in your browser:

In the next minutes, two e-mails are received in your mailbox. The first one is in HTML format, the other one in text format to verify the transmission of the first message and to help you to configure your anti-spam software.

If the messages are sent immediately by our web server, depending on the network conditions, the message could be received in a few seconds or in minutes. This message looks like the following:

Dear Sir/Madam,

You just registered your own copy of eMedia Card Designer software. Here is the needed activation Key:

Installation Key .... IK-X9CAQ-ANDM8-JNO01
License Key ........... LK-MEDE-MEDE1-21300-37997
Activation Key ...... AK-TEST-KEY

----- IMPORTANT ----- PLEASE READ -----------------------------------

Another e-mail in HTML format has been sent to you from our servers. This second e-mail contains all the license reference and must be kept in a safe place, as this second e-mail is the proof of licensing. If you didn't received this second e-mail,
And the second message, containing all the informations, to be kept carefully for any further reference, looks like this one:

In the meantime, the following dialog box appeared in eMedia Card Designer:

License Registration

Your data have been sent to our servers.

Check the internet browser window. If your data are correct, the message must tell you that the Activation Key has been sent. If an incorrect data has been entered, you may correct it from the form in the window.

Check your mail. You’ll receive a message from our server giving you the Activation Key that correspond to the Installation Key of your software copy. Just enter this Activation Key in the text-box below, and the features you requested will be enabled.
You just have now to enter the Activation Key in the corresponding text-box and to click on the "Next" button. The following dialog box appears:

![License Registration Dialog Box]

Your license is now enabled.

Click on "Next" to save the license informations in a file on the hard disk for any further reference,

Click on "Close" to close the dialog box and return to eMedia Card Designer.

You may want to check out if your license data have been defined. You may either select the "About" command or the "Register your license" command of the "Help" menu:

![License Registration Dialog Box with License Information]

Notice the link at the bottom of the dialog box. You may use it to notify us about any modification in the license information: user name, company, e-mail address, etc.
Please feel free to contact our support department if you have a question about the activation procedure or if you encounter any difficulty. We'll be pleased to help you.

No other information than the one provided in the software are collected by our license server. All these informations are strictly confidential unless you authorized us to provide them to third parties. These informations are intended to bring you the best possible support.

**Migration of a license**

The user license you bought allows you to use eMedia Card Designer on a workstation, and the Activation Key provided by our license server correspond to the Installation Key of this workstation.

However, you may require uninstalling this license for any of the following reasons (or for additional reasons):

- Major upgrade of the operating system,
- Installation of a new operating system,
- Hard disk formatting,
- Replacement of the workstation.

In these cases, you may remove the license to reinstall it on the same workstation, or on another workstation.

To do so, a tool is provided with eMedia Card Designer. It removes the license information and returns a Migration Key. This key will be usable with a new Installation Key to obtain from our license server a new Activation Key, 24 hours a day, 7 days a week.

This migration tool can be launched in two ways:

- From eMedia Card Designer, in design mode only (to avoid the user in operating mode to be able to do it), by selecting the "Migrate your license" from the "Help" menu,
- While uninstalling the software from the control panel, "Add or Remove Programs" icon.

**Uninstalling the license**

While you launch the migration tool, the following window appears on screen:

This splash screen gives you all the informations concerning the migration of the license.

Click on the "Next" button if you're ready to begin the migration process, or on the "Cancel" button to exit from this tool. You may also click on the "Help" button to obtain more help.
Let's continue the procedure. Click on "Next" and the following screen appears:

In this window, the license informations are shown and you may confirm the uninstallation of the license. If you're ready to continue the process, enter "Yes" in the text-box at the bottom of the window and click on the "Next" button.

The license is then removed from the workstation and a Migration Key is displayed:

Please note this Migration Key carefully, it will allow you to obtain your new Activation Key.

Then, click on "Finish". The window disappears. If eMedia Card Designer was running, it also closes. The Migration informations are automatically saved in a file (so you'll be able to retrieve in it the Migration Key if you didn't note it).

**Installation of the license**

You may now install or reinstall the operating system, perform maintenance tasks, format your hard disk, change the computer, etc. Once done, you may install or reinstall eMedia Card Designer on the computer.
Now, the Migration Key will help you to obtain your new Activation Key. This will be done exactly as you did for the first installation:

1. Launch eMedia Card Designer,
2. Open the "Help" menu and select the "Register your license" command,
3. Click on the "Register now" button.

The dialog box asking for the second key appears (the one shown page 42). Notice that the Installation Key is different from the previous one. Enter your Migration Key in the "Second key" text-box:

Click on the "Next" button. The following screen appears:

Please notice that the informations there will not be sent to our license server. These informations will only be displayed in the registration dialog box for further reference: you'll
be able to know the name, company and e-mail address of the user that owns the user license. This e-mail address will also receive our messages. We encourage you to enter the same data as the one entered in the previous copy of the software, even they are not correct.

Remember that the registration dialog box contains a link that allows you to contact our support department in order to ask for the modification of these data. You'll perform this modification in a second time.

Warning: if the e-mail address of the user license doesn't exist anymore or has been changed, you must contact our support department before performing the migration and before finishing the current procedure, as our internet license server will send the new Activation Key to the e-mail address defined for the first activation, AND THIS E-MAIL ADDRESS CAN ONLY BE CHANGED BY US to avoid piracy.

Click on "Next" once the informations entered, and the dialog box asking you for opening an internet connection appears (see page 43).

If you accept this connection and the transmission of the data, your internet browser appears and connects to our web server. The following page appears then:

This page shows the informations known by our servers (independently of the data entered in your software copy just before).

Notice that this page shows the e-mail address where the new Activation Key will be sent.

Accept these informations by clicking on the "I agree with this" link. The e-mail containing the new Activation Key is then sent, and the Migration Key is discarded. You'll not be able to use it anymore.

As for the first activation message, you'll keep the migration message very carefully, as it contains the user information and the Activation Key for your software copy. Maybe you'll have to send it back to our support department in the future.
A copy of this e-mail will also be sent to your reseller and to our support department for further reference and to take your migration in account, so you'll be able to contact us if you encounter a problem during the rest of the process.

eMedia Card Designer shows then the dialog box asking for the Activation Key (see page 45). The rest of the procedure is strictly identical to the procedure of the first activation.

**Help, I lost my license!**

A license may be definitively lost, as you may format the hard disk without uninstalling the software for instance.

As the user, you're responsible for the maintenance of your different software keys, and must do your best to keep them as secure as possible on the workstation.

This implies (and the list isn't finished) the installation of anti-virus and anti-spyware software on the computer, performing backups regularly and avoiding the installation of software from unknown sources.

If you managed your computer correctly but lost your license, contact our support department or our sales department, so we'll be able to review with you all the options that would help to resolve the issue.

**Problems or questions?**

At any time, during the activation of the migration, don't forget that the F1 function key is the first way to use for a solution. This key will call the online help that contains the most relevant responses to the most common questions.

Also, all the e-mail messages sent from our internet web server and from our license server are always sent to you, to our support department and to your reseller. So we are ready to help you if you encounter any problem with these messages.
5. CONTACT US

To contact us, the best way is to connect to our internet web server, in the "Support" section. You'll find there lots of web forms, from which you'll be able to tell us about your remarks, your problems, the errors you encounter, etc.

These forms are automatically sent to our support team, which responds to them as soon as possible, between 8:00 and 18:00 GMT, by e-mail.

When these questions are relative to the licensing, these forms are also sent to our sales department. You may contact them by e-mail at any time.

You may also browse our internet web site, mainly the "technical support" section, in which you'll discover lots of additional informations. http://www.emedia-cards.com

And, from our internet web site, you may gain access to our users' forum, in which you may post your questions, exchange your tips and tricks with us and the other users.

We don't provide any support by phone, mainly for resources reasons. We don't have a sufficient capacity to handle tenth of calls every day. Also, if a technician is able to resolve an issue in a few minutes by e-mail, the same issue needs much more time by phone, and we don't want our users to wait for a technician to be free.

So, don't wait, use the e-mail!

And by e-mail, you have the ability to send documents, card templates, pictures, etc!

The evolution of eMedia Card Designer since its first version was mainly due to the requests of our users. If you need an additional feature the software can't handle, please feel free to request it. We'll study if the feature will be useful for other users and will develop it in this case. Our goal is to make eMedia Card Designer the best design and printing tool for the plastic cards on the market. Help us in this challenge, you'll be the first to benefit from these features!

Your contacts are ready to help you:

- internet web site: http://www.emedia-cards.com
- Technical support: support@emedia-cards.com
- Sales department: info@emedia-cards.com